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Pioneering for You

Highly Efficient Pumping Solutions

Bangalore

Mather and Platt Pumps Ltd.

S & S Elite Building, 2™ Floor, No. 197,
10" Cross, CBI Road, Ganganagar,

R. T. Nagar Post, Bangalore-560 032
Ph: +91 80 23541887

Email: mnpblr@matherplatt.com

Bhubaneshwar

Mather and Platt Pumps Ltd.

B-15, 2" Floor, Arihant Plaza,

Shahid Nagar, Bhubaneshwar—751 007
Ph: +91 674 2541738

Email: mnpbhu@matherplatt.com

Chandigarh

Mather and Platt Pumps Ltd.

SCO 18, FF, Cabin No. 4, Sector 26,
Madhya Marg, Chandigarh-160 026
Ph: +91 172 3913891

Email: mnpchd@matherplatt.com

Chennai

Mather and Platt Pumps Ltd.

2" Floor Mootha Centre 23, Kodambakam
High Road, Nungambakkam, Chennai-600 031
Ph: +91 44 28251171

Email: mnpchn@matherplatt.com

Delhi Email: mnpngp@matherplatt.com
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*Technical matter subject to change

Jaipur

Mather and Platt Pumps Ltd.
317, 2" Floor Apex Mall,

Tonk Road, Jaipur — 302 015
Ph: +91 141 4038844

Email: mnpjai@matherplatt.com

Kolkata

Mather and Platt Pumps Ltd
“Shaila Towers”, 3 Floor,
J1/16, EP Block, Sector V,

Salt Lake City, Kolkata—700 091
Ph: +91 8100218116

Email: mnpkol@matherplatt.com

Lucknow

Mather and Platt Pumps Ltd.
F-2(D), 2"Floor, A. F. Tower,
Park Road, Hazaratganj,
Lucknow-226 001

Ph: +91 522 2239556

Email: mnplko@matherplatt.com

Nagpur

Mather and Platt Pumps Ltd.
A-1, Ground Floor, Avanti Appt.,
Plot No 300, Lakshmi Nagar,
Nagpur - 440 022

Ph: +91 712 2245519

Thane

Mather and Platt Pumps Ltd.

601, Dev Corpora, 6" Floor,

Opp. Cadbury Company,

Eastern Express Highway, Khopat,
Thane (W)-400 602

Ph: +91 20 41222411

Email: mnpmum@matherplatt.com

Vadodara

Mather and Platt Pumps Ltd.

316, Race Course Tower, Race Course Circle,
Gotri Road, Vadodara-390 007

Ph:+91 265 2334289

Email: mnpbrd@matherplatt.com

for Building Services
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02  Introduction

The company at a glance

WILO SE, based in Dortmund, Germany is one of the world's leading
manufacturers of pumps and pumping systems for heating, cooling and
air conditioning, water supply, sewage disposal and industrial
applications. With more than 15 production sites over 60 subsidiaries,
and more than 7,000 employees around the world, Wilo is a true global
player.

Founded in 1872 as the Louis Opldander Copper and Brass Goods
Factory, the company has developed to become the leading innovator
in the high-tech pump sector.
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Wilo Branches/Production Sites

Mather and Platt Pumps Ltd.

Mather and Platt started its Indian operation in the year 1913 from Kolkata. Since then we
have been significant in fulfilling the need of water supply for more than 100 years in India to
various business segments like building services, water management and industries. Our
Chinchwad Works operations in Pune, Maharashtra started in the year 1959.

Today, we are the manufacturers of the various types of centrifugal pumps and pumping
systems.

Mather and Platt Pumps Limited became a part of WILO SE in the year 2005.

A new state of art manufacturing facility at Kolhapur, approximately 260km from Pune, and
covering over 6000 sq. meters was inaugurated in the year 2011, to manufacture the latest
high efficiency products of Wilo India.
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The Pune and Kolhapur plants have acquired the 1ISO 9001,
ISO 14001 and OSHAS 18001 Certifications and all our
products are CE certified. M+P is the manufactures of one of
the largest metallic vertical turbine pump in Asia supplied
with 4 MW motor.

A Green feather in the cap.....
In April 2013, our Kolhapur plant received a
from the Indian Green Building Council (IGBC).

1890 1940 1978 2007 2011
Mather+Platt First Factory Mather+Platt became Mather + Platt aquired State-of-the-art
entered India started in Kolkata Indian Company ACP Kolkata manufacturing facility
inagurated at Kolhapur
1870 1913 1959 2005 2009
First Pump built by Mather+Platt Second Factory Aquired by Manufactured
Mather+Platt operations started in started in Pune WILO SE, Germany largest metallic pump
India with 4 MW motor
1872
Wilo was
founded

WILO SE, Dortmund plant/Germany

WILO SE, Oschersleben plant/Germany

WILO SE, Holf plant/Germany

WILO EMU Anlagenbau GmbH, Roth/Germany*
Pompes Salmson S. A. A, Laval plant/France
TEK S. 1. 1., Bari/italy*

WILO Pumps Ltd., Limerick/ireland

Circulating Pumps Ltd., Kings Lynn/Great Britain
WILO USA LLC, Thomasville plant, Georgia/USA
WILO China Ltd., Beijing plant/China

WILO ELEC China Ltd., Qinhuangdao/China
WILO Pumps Ltd., Busan plant/Korea

Mather & Platt Pumps Ltd., Pune plant/india
Mather & Platt Pumps Ltd., Kolhapur plant/india
Mather & Platt Pumps Ltd., Kolkata plant/india

SUBSIDIARIES
With more than 60 subsidiaries, Wilo is at home all
over the world
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Water is life.
And since 1872, Wilo has been connecting
people with water.
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Wilo - Dry Rotor Pumps

BSC Brochure

Wilo - Multi Pump Pressure Boosting System
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Product End Suction Back Pull Out Pumps Vertical Inline Pumps Horizontal Split Case Pumps Product CO - X XXX BC/EC €O (R) = X Xxx/cc COR - X XXX/VR
ET/NL/PN ILAPL/DL/PIL ST/SN/LONO/LE/ME/SCP
Range Flow upto: 750 m*/hr Flow upto: 800 m’/hr Flow upto: 18000 m*/hr Range Flow upto: 400 m’/hr Flow upto: 800 m’/hr Flow upto: 400 m*/hr
Head upto: 170 m Head upto: 110 m Head upto: 270 m Head upto: 110 m Head upto: 200 m Head upto: 200 m
Temperature: up to 120°C Temperature: up to 140 °C Temperature: up to 120°C Temperature: up to 70°C Temperature: up to 70°C Temperature: up to 70°C
Delivery size: DN 32 - DN 150 Delivery Size: DN 32 - DN 250 Delivery Size: DN 32 - DN 1200 Delivery size: DN 32 - DN 200 Delivery size: DN 32 - DN 200 Delivery size: DN 32 - DN 200
Product/ > Conforms to ISO 2858 & EN 733 > Available with IE2 motor > Single/double suction impellers No of pumps — 2 to 4 No of pumps — 210 8 No of pumps — 2 to 4
Design > Back pull out design > Mechanical seal as a standard - Grease/oil lubricated antifriction o . o
EE e > Closed/semi open impellers > Flameproof motor (optional) bearings. Product/ - Indication lights > P.LC Based system (CO) and with > PLC based system with individual
> Grease/oil lubricated antifriction > Mechanical seal/gland packing Design > Cascading, altering function single VFD (COR) VFD for each pump
bearings ERRCOrES > Overload protection > HMI touch screen > LCD with back lit display
> Mechanical seal/gland packing > Main Switch with door interlock > Multi colour display > BMS compatibility
> Adjustable timer for run/stop > Three stage security password > Internal circuit breaker with door
pumps -> Alphanumeric error message interlock
> Dry run protection with capacity of 35 messages > Each pump operation status
> Factory made systems > BMS compatibility > Password protection facility
> Pump test run facility > On screen menu driven functions
> Factory made systems with rotary switch
> Factory made systems
Material of > Casing: Cast iron/SS/NiCi/WCB > Casing: Cast iron > Casing: Cast iron/SS/NiCi/WCB
Construction > Impeller: Cast iron/Bronze/SS/ > Impeller: Cast iron/bronze > Impeller: Cast iron/ Bronze/SS/
NiCi/WCB NiCi/WCB Material of = Pumps with SS 304 internals - Pumps with SS 304 internals > Pumps with SS 304 internals
Construction > Manifolds, base frame — Gl > Manifolds, base frame — Gl > Manifolds, base frame — Gl
- Other material of construction > Other material of construction > Other material of construction
available on request available on request available on request
Applications > HVAC systems > HVAC systems > HVAC systems
> Water transfer > Water transfer > Water transfer
> Distribution systems > Distribution systems > Distribution systems Applications > Pressure boosting > Pressure boosting > Pressure boosting
> Fire fighting > Cooling tower > Fire fighting - Tankfilling > Tank filling > Tank filling
- Cooling tower > Cooling tower > Water transfer > Water transfer > Water transfer
> Gardening
Options > With complete SS 304 monobloc > With complete SS 304 monobloc > With vertical multistage pumps in
Available pumps pumps SS 316L and SS grade of manifolds
> With vertical inline multistage > With vertical multistage pumps in > BMS compatibility with
pumps SS 316L and SS grade of manifolds Communication system
-~ BMS compatibility with

Communication system
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Quality.
This is what matters

BSC Brochure

Wilo - Submersible Drainage and Sewage Pumps
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Inbuilt level sensor

Inbuilt level sensor

Flameproof motor (optional)

Product Submersible Dewatering Pumps Submersible Sewage Pumps Submersible Cutter Pumps
FAS/MPDP/CP/DP/KS/TS TC/STS/FAC/TP/FA/MPSP MTS/MTC
Flow upto: 340 m’ Flow upto: 8000 m’, Flow upto: 19 m’
Range w up /hr w up /hr w up /hr
Head upto: 68 m Head upto: 100 m Head upto: 56 m
Temperature: up to 95°C Temperature: up to 60 °C Temperature: up to 70°C
Delivery size: DN 32 - DN 100 Delivery size: DN 32 - DN 600 Delivery size: DN 32 - DN 40
Passage size: up to 25 mm Passage size: up to 200 mm
Product/ Available in single & three phase > Available in single & three phase > Avai!able in single &AThree Phase
Design Stationary/portable installation > Stationary/portable installation > Stationary/portable installation
ERRTarES With/without agitator > With/without agitator > Inbuilt level sensor
> >
%

Wet pit/dry pit installation
Flameproof motor (optional)

N N N N2

Flameproof motor (optional)

Material of
Construction

> Casing: Cast iron/SS/polyurethan
Impeller: Cast iron/SS/
polyurethane

v

> Casing: Cast iron/SS/polyurethan
> Impeller: Cast iron/SS/
polyurethane

> Casing: Castiron
> Impeller: Castiron

Applications

> Basement dewatering
> Dewatering at construction sites
> Treated effluent transfer

> Sewage transfer
Sewage effluent transfer
> Sewage treatment plants

v

Kitchen sewage

Hospital waste water
Sewage transfer

Sewage effluent transfer

N 2 2
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Wilo - Fire Fighting Sets

Product Multistage pumps Multistage multi outlet pumps
Range Flow upto: 1000 m’/hr Flow upto: 1000 m’/hr
Head upto: 1500 m Head upto: 1500 m
Temperature: up to 160°C Temperature: up to 160 °C
Delivery size: DN 32 - DN 250 Delivery size: DN 32 - DN 250
Product/ > Stages:3to15 > Stages:3to15
Design - Radial flow impellers with vane - Multi outlet design
Features diffusers - Radial flow impellers with vane
> Mechanical seal/gland packing diffusers
> Grease lubricated anti-friction > Mechanical seal/gland packing
bearings > Grease lubricated anti-friction
bearings
Material of > Casing: Cast iron/SS/NiCi/WCB > Casing: Cast iron/SS/NiCi/WCB
Construction > Impeller: Cast iron/Bronze/SS/ > Impeller: Cast iron/Bronze/SS/
NiCi/WCB NiCi/wcB
Applications > Fire fighting for high rise buildings > Fire fighting for high rise buildings

> Pressure boosting
> Water transfer

Electric Motor Driven Sets

End suction, horizontal split case,
multistage-single/ multi outlet
pumps with electric motor.

> Enclosure-TEFC/SPDP
> Voltage - 415V
> Frequency - 50 Hz

Diesel Engine Driven Sets

End suction, horizontal split case,
multistage-single/ multi outlet
pumps with radiator cooled and
heat exchanger cooled diesel
engine.

Accessories (On request):

- Control panel

> Fueltank

> Battery

> Battery cable

Jockey Pump

End suction and vertical inline
multistage pumps with electric
motor.

> Enclosure-TEFC/SPDP
> Voltage-415V
-~ Frequency-50 Hz

BSC Brochure
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Product Vertical Inline Multistage Pumps Vertical Inline Multistage Pumps Horizontal Monobloc
MVI Helix (SS Version)
Range Flow upto: 140 m’/hr Flow upto: 85 m’/hr Flow upto: 24 m’/hr
Head upto: 220 m Head upto: 240 m Head upto: 65 m
Temperature: up to 120°C Temperature: up to 120°C Temperature: up to 110°C
Delivery size: DN 25 - DN 100 Delivery size: DN 25 - DN 80 Delivery size: DN 25 - DN 40
Product Self Priming Monobloc Pumps Non Self Priming Monobloc Pumps Open Well Submersible Pumps
Range Flow upto: 5 m’/hr Flow upto: 110 m’/hr Flow upto: 88 m’/hr
Head upto: 50 m Head upto: 80 m Head upto: 62 m
Temperature: up to 40°C Temperature: up to 60°C Temperature: up to 40°C
Delivery size: DN 40 - DN 80 Delivery size: DN 40 - DN 80
! l |
i i
il | i |
Product Single Pump Booster Circulators Bore Well Pumps (SS Version)
Range Flow upto: 13 m’/hr Flow upto: 100 m’/hr Flow upto: 130 m’/hr

Head upto: 65 m

Head upto: 18 m

Head upto: 420 m

Temperature: up to 60°C

Temperature: up to 110°C

Temperature: up to 40°C

Delivery size: DN 25 - DN 40

Delivery size: DN 32 - DN 150
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High Efficiency

Water supply.
Why big ideas need pressure

CCS HVAC Controller

Variable speed Pump Control unit for HVAC System.

Wilo-Mather and Platt Pumps Limited CCS HVAC (Comfort Controller HVAC)
controlleris based on state-of-the-art-technology with flexibility to meet the
current and future customer requirements. The CCS HVAC Controlleris specially
designed for automatic control for pumps in parallel, integrated with Variable
frequency drives in duty as well stand by operation in heating ventilation and air
conditioning application. The CCS HVAC controller is equipped with a multi
color, wide screen, user friendly touch screen with HMI(Human machine
interface) which offers a very simplified control and input unit, menu navigation
foreasy operationand control.

The CCS HVAC Controller operates the pumps to meet the changing system
demand received by the sensors by varying the speed of the pumps to meet the
systemrequirementandresultingin energy saving operation.

Standard Features

> Wall Mounted/Floor Mounted Enclosure

Internal Circuit breaker with door interlock

System can control 1 - 6 pumps, extendable up to 8 Pumps

Microprocessor based pump logic controller.In built PID with
auto/manual tuning

Embedded logic to prevent pump hunting, pump flow surges and
motor overheating

Multi color, wide screen (5.6”), High resolution HMI with 24VDC
power supply

On screen menu driven functions

Manual and Automatic System control (Man-off-Auto)

Multi level user password security

Alpha Numerical Alarm and Fault data login

Remote start/stop mode - Real time Clock

End Of curve protection - 3 Different set points
Each Pump operational data - Remote set point

Set value VS process value Graph

Sensor operation mode selection i.e. Max, Min, Avg, or Most
deviated

Communication ports RS232, 2xRS 485, 2xUSB

Each VFD data read out on screen

Supports Mod Bus RTU Protocol

Controllers available with VFD’s, with/without bypass starter and single/
multiple DPT’s. VFD inside the enclosure with/without bypass starter and
single/multiple DPT’s. Customised panels on request.

- Analogue inputs for Remote set point, Differential pressure sensors

and Flow

2 vy

N

N2 20 2 2 2 2 2N 2N 2

vy v

Optional Features
- Encl with or without provision for VFD

- BACNET, Ethernet TCP/IP and other communications protocol
modules on request

Dimensional Data
> Size(inmm) : 500hx500wx250d
- Approximate Weight : 30Kgs
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VR HVAC Controller

Variable speed Pump Control unit for HVAC System.

Wilo-Mather and Platt Pumps Limited, VR HVAC Controller is specially designed
for automatic control of pumps in heating, ventilation and air conditioning
applications. The VRHVAC controller is used along with Variable frequency
drives and Differential transmitter to control the differential pressure in a
system as a function of the load. VR HAVC controller offers a simplified control
and ease of operation. The VR HVAC Controller operates the pumps to meet the
changing system demand received by the sensors by varying the speed of the
pumps to meet the system requirements and resulting in energy saving
operation.

Standard Features

Wall Mounted/Floor Mounted Enclosure.
Internal Circuit breaker with door interlock.
System can control 1-4 pumps max.
Automatic pump alteration.

Duty and standby selection of the pump.

Microprocessor based pump logic controller with
built in PID.

Control Modes Delta PC and Delta PV.

Embedded logic to prevent pump hunting, pump
flow surges and motor overheating.

LCD with Back-lit Display.

On screen menu driven functions with rotary
switch.

Emergency operation mode.
Password protection for security.
Alarm and Fault data login.

Common Failure and Operation relays.
Remote start/stop mode.

Analogue inputs for Remote set point.
Each Pump operational data.

N N 2N 2NN

vy

vy
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Optional Features.
- Encl with or without provision for VFD.

- Communication ports to receive data from Variable
frequency drive.

Dimensional Data
> Size (in mm) : 500hx500wx250d
- Approximate Weight ~ : 30Kgs.
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References

The Hague City Hall,
The Hague, Netherlands, Europe

The Place, Beijing,
Beijing, China, Asia

Olympic Stadium,
Kiev, Ukraine, Europe
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Shopping center GIPPO,
Minsk, Belarus, Europe
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HVAC

10 Nos pump sets for primary pumping
6 Nos pump sets and control panels
for secondary pumping

FIRE
10 Nos pump sets for condenser pumping
11 Nos fire fighting sets along with jockey pump

Client:
Amanora Park Town Mall, Pune

Supply:

3 Nos Multistage Multioutlet

Fire fighting Pumpsets

Client:

The Grand Central (ITC Hotel), Mumbai
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Supply:

7 Nos pressure boosting system

12 Nos dewatering/ sewage submersible pumps
6 Nos control panels for dewatering/ sewage
submersible pumps

24 Nos HVAC pumpsets

4 Nos Fire fighting pumps sets

Client:

Seven Hills Hospital, Mumbai

Supply:
6 Nos pressure boosting systems
22 Nos dewatering/ sewage submersible pumps

11 Nos control panels for dewatering/ sewage
submersible pumps

Client:
Hotel Sofitel, Mumbai




